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1 INLEDNING

1.1 Bakgrund

Sjalvstandig musikproducering blir allt mer populart i dagens lage och det &r lattare att
bygga sig en egen hemmastudio &n forr. Det blir allt vanligare for en sjalvstandig
musiker att anvanda sig av virtuell studioteknologi, del orsakat av en begransad budget,
sa som anvanding av datortrummor och ljudpluginner for sina egna produktioner.

Jag har inte tidigare stott pa ett liknande examensarbete som behandlar enbart denna stil

av musikproduktion, vilket héjde mitt intresse for att vélja detta amne.

1.2 Syfte och mal

Syftet med detta arbete ar att undersoka hur en gitarrist kan gora en musikproduktion pa
egen hand enbart med anvéandning av virtuell studioteknologi. Malet &r att uppna en
musikproduktion av bra kvalitet med hjalp av denna teknologi och metoderna som
anvands. Fragor som ska besvaras ar da:

e Hur gor man en sadan slags musikproduktion?

e Hurdant blir slutresultatet?

e Hur paverkar den begransade budgeten produktionen?

e Lonar det sig att gora en sadan slags musikproduktion och i sa fall varfor?

1.3 Metoder

Jag anvander mig av kunskap jag fatt pa yrkeshogskolan Arcada och yrkesinstitutet
Prakticum och dessutom egna erfarenheter och inl&rningar for att utfora detta arbete.
Forskningen baserar sig starkt pa bocker och internetbaserade kéllor, pga. att det ar den
béasta metoden for att fa faktabaserat material inom omradet. Teorin omsétts i praktiken
da jag gor min egen produktion, vilket gor en palitlig undersokning. Ifall problem som
inte kan l6sas med hjélp av kéllor dyker upp, vore det sen svar som inte hittas eller

Overhuvudtaget finns i litteratur, bor jag sjalv 16sa problemen genom att prova.



1.4 Avgransning

Jag behandlar bara de omraden som jag sjéalv anvander till den konkreta produktionen
jag gor, pga. att arbetet skulle annars bli allt for brett. Jag kommer inte heller att ga
igenom allting till minsta detalj, t.ex. hur jag ekvaliserar alla spar, pga. att arbetet skulle
bli allt for brett och det ar inte heller vasentligt till denna forskning. Jag tar anda upp
viktiga aspekter inom alla omraden jag gar igenom. Eftersom jag inte inkluderar sang,
riktiga trummor och riktig synt till min produktion kommer de inte heller att behandlas i
forskningen. Mickning av forstarkare lamnas ocksa bort for att virtuella
studioteknologin ersatter detta. Jag kommer inte heller att behandla akustik, vilket ar en
central del for en bra studiomiljo, pga. att jag inte sjalv sétter in mig i uppbyggning av
en bra studio for denna produktion. Forskningen exkluderar dessutom komponering av
musik (berdr inte skapandet av datortrummor och datorsynt) och fragor gallande

distribuering.

2 FORBEREDELSER

2.1 Utrustning

Dé man valjer utrustning for sin musikproduktion galler det i allmanhet att tanka pa
flera fragor, t.ex.:

e Vad ar budgeten?

e Anvands mickning?

e Hur manga ingangar behovs i ljudinterfacet?

e Bandas allting med riktiga instrument eller anvands sekvenserare?
(Strong s. 18-20) For detta projekt ar dessa fragor redan delvis besvarade men klarlaggs

aven ytterligare i detta kapitel.

2.1.1 Budget och dess begrénsningar

Budgeten &r begrénsad till att inte kunna banda riktiga trummor och riktig synt, utan
istallet anvands virtuella instrument (VSTi). FOr gitarr och bas anvands virtuell

studioteknologi istallet for mickning av forstarkare.
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Detta resulterar ett betydligt mindre krav pa utrustning och budget, samt ger chansen for
en gitarrist att gora en musikproduktion sjalvstandigt utan att behdva kunna spela alla
instrument. Denna studioutrustning innebér bara det vasentliga, dvs. dator, ljudinterface

och ljudanlaggning.

Budgetanalys av studioutrustningen for denna forskning:
e Acer Aspire 5560G — 600-700 € (barbar dator)
e Focusrite Scarlett 2i2 —136,90 € i Verkkokauppa (ljudinterface)
e Sennheiser PXC 150 — 100-130 € (horlurar)
e Behringer M-Audio Studiophile BX5a Deluxe — 166 € i Thomann 2011 (2 st stu-
diomonitorer)
Total summa: 1000-1150 €

2.1.2 Dator

Det &r viktigt att ha en ndgorlunda bra processor i sin dator eftersom det ar den
huvudsakliga faktorn som driver ljudbearbetningsprogrammet. RAM-minne pa minst 8
GB &r rekommenderat (Strong 2014 s. 24).

I denna forskning anvéands Acer Aspire 5560G vilket bevisar att medelkraftiga barbara
datorer klarar av musikproduktion. Denna musikproduktion &r ett ytterligare bevis pa

pastaendet.

Acer Aspire 5560G specifikationer:
e AMD Quad-Core Processor A8-3500M
med Turbo CORE Teknologi upp till 2,40 GHz
e 8 GB DDR3 minne (RAM)
e Windows 7 64 bit
e AMD Radeon HD 6740G2, 1 GB tillagnad VRAM

Medelkraftiga datorer kan dock ha problem med uppspelning om fér manga

ljudpluginner ar aktiva samtidigt (se delkapitel 2.2.3).



2.1.3 Ljudinterface

Ett ljudinterface, alias ljudkort, fungerar som en anslutningsbrygga mellan den analoga
och digitala ljudvérlden. Eftersom datorns egna ljudkort ofta inte & menat for
musikproduktion I6nar det sig i sa fall att anvanda ett externt ljudkort. (Huber, Runstein
2010 s. 249) | denna forskning anvénds Focusrite Scarlett 2i2 som ljudinterface. Scarlett
2i2 har tva ingangar vilket racker bra eftersom det enda som bandas i denna produktion
ar gitarr och bas. Enligt Scarlett 2i2: s specifikationer gar det att banda med t.0.m. 96
kHz samplingsfrekvens och 24 bitar vilket racker utmérkt (Focusrite Specifications).
Scarlett 2i2 har gain kontroller samt line och instrument omkopplare for bada
ingangarna, direkt monitor funktion och majlighet for fantommatning. Focusrite Scarlett
2i2 ar ett simpelt externt ljudinterface som passar bra till musikproduktion av denna
kaliber.

2.1.4 Horlurar och studiomonitorer

Det ar bra att anvanda sig av bade horlurar och studiomonitorer da man producerar
musik. Horlurar eliminerar rumsakustiken i lyssningen men ger da inte alltid en sann
bild om hur ljudet later da det kommer ur en hogtalare. Anvandning av hérlurar kan
vara bra i mixningsskedet om man inte vill att akustiken och reflektioner paverkar ljudet
(Huber, Runstein 2010 s. 541-542). Horlurar och hogtalare for musikproduktion bor
vara relativt linedra i fraga om hurdan fas- och frekvensrespons de éterger for att ljudet
ska vara sa verklighetstroget som mojligt. Sddana hogtalare kallas for studiomonitorer
(Wikipedia 2015a). Detta betyder att man inte vill att horlurarna och hogtalarna aterger
overlopps forstarkningar pa nagot visst frekvensomrade, t.ex. forstarkning pa laga
frekvenser, vilket ljudanlaggningar som inte &r menat foér musikproduktion ofta gor. Till
detta arbete anvénds Sennheiser PXC 150 horlurar och Behringer M-Audio Studiophile

BX5a studiomonitorer.
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2.2 Mjukvara

2.2.1 Ljudbearbetningsprogram

Fore man valjer sitt ljudbearbetningsprogram lonar det sig att ta reda pa andras
erfarenheter med programmet, sérskilt ifall programmet kostar. | denna forskning
anvands Reaper (Rapid Environment for Audio Production, Engineering and Recording)
som ljudbearbetningsprogram. Reaper ar ett utmarkt flersparigt
ljudbearbetningsprogram gjord av Cockos man kan ladda ner fran deras hemsida till
bade PC och Mac. Fackpressen anser Reaper vara ett bra alternativ till andra
professionella ljudbearbetningsprogram som Cubase och Pro Tools (Wikipedia 2016b).

2.2.2 Drivrutin

Med hjélp av ett audio drivrutins protokoll gar det att reducera latens genom att
optimera drivrutinens buffert instéllning till en l&gre operativ storlek (Huber, Runstein
2010 s. 252). Om den operativa storleken ar for liten sker det hackning i ljudet vilket
inte heller ar onskat. Det galler alltsa att stalla det i ett optimalt lage sa att det inte sker

hackning i ljudet och att latensen inte stor.

Borde man da vilja ljudkortets egna drivrutin (ifall det finns) eller nagon annan? For
Focusrite Scarlett 2i2 gar det att anvanda Focusrite USB 2.0 Audio Driver som ar
héardvarans egna drivrutin. Man skulle tro att hardvarans egna drivrutin ar det basta
alternativet, vilket flera musikproducenter pastar (Reddit Forum 2015), men det ar inte
sagt. ASIO4ALL ar ett bra alternativ till den nativa drivrutinen for ljudkortet och &r vart
att prova. ASIO4ALL é&r en gratis drivrutin som ar hardvaruoberoende vilket betyder att
det gar att anvanda tillsammans med t.ex. Focusrite Scarlett 2i2 (ASIO4ALL Project
Brief).

Har ar en jamforelse mellan ASIO4ALL och Focusrite USB 2.0 Audio Driver:

[44.1kHz 24bit WAV : 2/2ch 288spls ~12/11ms ASIO]
Figur 1. ASIO4ALL 288 samplar, 12/11 ms latens
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[44 1kHz 24bit WAV : 2/2ch 265spls ~13/19ms ASIO]

Figur 2. Focusrite USB 2.0 Audio Driver 265 samplar, 13/19 ms latens

Bada alternativen har samma instéllningar: 44,1 kHz samplingsfrekvens och 24 bitar.
Det visar sig att ASIO4ALL ger mindre latens fastan den ocksa har en aning storre
operativ storlek. Andra musikproducenter har ocksa fatt mindre latens med ASIO4ALL
(KVR audio Forum). ASIO4ALL anvéands som drivrutin for denna musikproduktion

eftersom den ger mindre latens i detta fall.

2.2.3 Ljudpluginner

Virtuell studioteknologi (VST) och Jesusonic (JS) ljudpluginner &r de huvudsakliga
elementen fOr skapandet och justering av sound i denna stil av musikproduktion. VST
anvander digital signal processering for att simulera traditionell studio hardvara i form
av mjukvara (Wikipedia 2016c¢). Trummorna och syntarna ar virtuella instrument
(VSTi) och gitarrens samt basens sound skapas fullstandigt med VST och JS
ljudpluginner. Ljudpluginner ar ofta mycket justerbara och det finns massor pa internet
det gar att ladda ner, antingen gratis eller mot avgift. JS ljudpluginner gar det dessutom

att modifiera vid behov eftersom de ar programmerbara text filer (JSFX Programming).

Ljudpluginner anvander processorkraft som kan orsaka att datorn blir langsammare da
manga ljudpluginnar ar aktiverade. Det kan leda till att arbetande blir outhérdligt och
man maste vidta atgarder. Da finns det nagra alternativ man kan gora. Forst I6nar det sig
att stélla drivrutinens buffert till en stérre operativ storlek och se om det l6ser
problemet. Detta dr dock inte ett bra alternativ om sadana problem uppstar redan i
inspelnings-skedet eftersom det paverkar latensen. | mixningsskedet kan det vara en bra
metod. Man kan ocksa banda sparet med effekten aktiverad till ett annat spar och pa sa
satt behover man inte anvanda ljudpluginnen (se kapitel 3) (Strong 2014 s. 300). Pa det
nya sparet finns alltsa det gamla sparet med effekten spelad in. Alternativt kan man
inaktivera pluginner sa att datorn fungerar béttre och rendera projektet da man vill hora

alla pluginner aktiverade. Ljudpluginner har ocksa processorfordrojning som kan bli
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markbar om det orsakar for mycket latens pa ett visst spar. Da kan det vara att man
maste flytta pa sparet sa att det inte ar fordrojt i forhallande till resten av sparen, ifall
ljudbearbetningsprogrammet inte automatiskt korrigerar fordréjningen for pluginnen
(Crich 2010 s. 138-139).

2.2.4 Guitar Pro 5

Guitar Pro 5 ar en utmarkt flersparig tabulatur editor for att skriva, lasa och lyssna pa
tabulaturer som MIDI. En tabulatur ar ett populart alternativ istallet for noter i musik.
For denna musikproduktion komponeras trummorna och syntarna i Guitar Pro 5, vilket
ar forsta skedet i skapandet av datortrummor och datorsyntar. Man kan exportera Guitar
Pro projektet till en .mid fil som gar att importera till Reaper.

2.2.5 Ezdrummer

Ezdrummer ar en mjukvarusynt (VSTi) som baserar sig pa samplar av riktiga trummor
med samplingsfrekvensen 44,1 kHz och bitdjupet 16 (Wikipedia 2015d). Denna
mjukvara kan anvandas for att skapa datortrummorna med Ezdrummers egna trumkomp
eller med att anvanda en utomstaende .mid fil. Ezdrummer ersatter MIDI soundet for
.mid filen med programmets egna samplar. | Ezdrummer kan man ha flera olika trumset
att vélja mellan och dessutom har varje trumma och symbal alternativa samplar att vélja
mellan. I denna forskning anvands Ezdrummer for att skapa soundet till datortrummorna

for musikproduktionen.

2.3 Uppsaéttning

Fore inspelning maste man skapa ett Reaper projekt och se till att man har ratta
instéallningar i fraga om samplingsfrekvens och bitdjup samt synkronisering mellan
Reaper, drivrutin och ljudkort. Dessutom bér man satta upp trummorna och syntarna
ifall man vill hora dem da gitarren och basen spelas in. Tempo- och taktkartan satts
ocksa upp i samband med importering av trummornas eller syntarnas .mid fil. Soundet
for trummorna och syntarna behovs inte justeras i detta skede. Justering av sound med
hjélp av ljudpluginner, som t.ex. ekvalisering, dter processorkraft vilket man inte vill da

man ska banda. Darfor ar det bast att 1amna det till mixningsskedet.
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2.3.1 Samplingsfrekvens och bitdjup

Enligt Focusrite Scarlett 2i2: s specifikationer gar det att banda med 96 kHz
samplingsfrekvens och 24 bitar (Focusrite Specifications). Det betyder dock inte att det
I6nar sig att gora sa. Enligt Nyquistfrekvensen racker 44,1 kHz for att tacka manskans
hela horselomrade, dvs. 44,1 kHz pa hélft ar 22,05 kHz. Om man hojer pa
samplingsfrekvensen orsakar det storre filstorlekar for att fanga frekvenser som &r
ohorbara av manskohdrseln (Karma-lab wiki). Dock pastas inspelning i 96 kHz ocksa
ha fordelar. Det kan ha skillnad i situationer dar t.ex. en hi-hat spelas in pa narhall med
en kondensator mikrofon med stark hog frekvens (HF) respons. | 44,1 kHz fungerar
anti-alias filtret inte nédvandigtvis lika bra i sadan situation och kan orsaka aliasing
problem, som gor att Gvre dnden av hi-hatten later odnskat strav. Hi-hattens dvertoner i
23 kHz forekommer da i 21,1 kHz, vilket pastas lata omusikaliskt. Att banda i 96 kHz
skulle lésa detta problem eftersom anti-alias filtret omsatts da i hogre frekvenser (Hugh
Robjohns 2014). En annan férdel med att banda i 96 kHz &r da ljudpluginner internt
samplar upp till 96 kHz. Det skulle undvika samplingen och pa sa satt minska pa
systemets latens (Hugh Robjohns 2014). Det debateras ocksa om man ska banda i 44,1
kHz eller 48 kHz. Egentligen borde det ha ingen skillnad eftersom 48 kHz fangar mer
frekvenser hogre an manskans horselomrade. Men samma som med att banda i 96 kHz
kan 48 kHz minska risken for aliasing. Anvander man externa samplar eller loopar kan
det 16na sig att banda i 44,1 kHz for att undvika konvertering eftersom storsta delen av
samplar eller loopar ar bandat i 44,1 kHz (Karma-lab wiki). Det galler ocksa
Ezdrummer, vars samplar har samplingsfrekvensen 44,1 kHz och 16 bitdjup (Wikipedia
2015d).

Bitdjupet berér dynamiken som betyder att 24 bitar ger ett stérre dynamiskt omrade &n
16 bitar. Det ger storre huvudutrymme och pa sa sétt minskar risken for 6verbelastning
och klippning av ljudet, vilket gor det ett sdkrare alternativ att banda med (Huber &
Reinstein 2010 s. 214) (Youtube 2013a). Ifall musiken branns pa en CD-skiva och
konverteras till 16 bitar har man danda fordelen med att banda med 24 bitar
(Musicianself). Fastan Ezdrummers samplar ar i 16 bit gar det anda att banda 6vriga
instrument med 24 bitar och rendera i 24 bit. Detta ger inte upphov till problem.
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Eftersom 44,1 kHz inte har markbara nackdelar, om ens nagon éverhuvudtaget, stalls
samplingfrekvensen pa 44,1 kHz for denna musikproduktion. Pa detta vis undviks ocksa

konvertering av samplar. Bitdjupet stélls till 24 bitar for att fa mer huvudutrymme.

2.3.2 Synkronisering mellan Reaper, drivrutin och ljudkort

Efter att ha installerat ASIO4ALL ska man satta installningarna i Reaper.
| Reaper syns ASIO ljudsystemet under ”Options>Preferences>Devices>Audio
System”. Under ASIO Driver fliken hittar man ASIO4ALL. | ASIO4ALL

konfigurations fonstret gar det att valja sitt ljudkort som i detta fall &r Scarlett 2i2 USB.

g N
B ASIO4ALL v2.10 - www.asiodall.com - feedback@asiodall.com e

WDM Device List Latency Compensation

Realtek High Definition Audio In: 32 Samples e ——
Scarlett 22 USB Out: 32 Samp]es ll_

&
]

Options
[l Hardware Buffer (Does not always work)
Kemel! Buffers: 2 1
[l Always Resample 44.1kHz <-> 48kHz
[l Force WDM Driver To 16 Bit
ASIO Buffer Size = 512 Samples

Figur 3. ASIO konfiguration for ASIO4ALL drivrutin

I ”Devices” rutan i Reaper ska Scarlett 2i2 USB synas for bade in- och utgangarna
(Youtube 2010b).

2.3.3 Uppsattning av datortrummor

Komponering av trummor kan vara svart ifall man inte har erfarenhet och i sa fall kan
det vara bast att anvanda Ezdrummers egna trumloopar for att skapa ett bra trumspar.
Komponering av MIDI trummor kan ske pa olika satt beroende pa vilket program man
anvénder. T.o.m. Guitar Pro 5 och Guitar Pro 6 har olika satt att skapa trummor. | denna
forskning anvands Guitar Pro 5 dar man skapar trummorna som en tablatur. D man
skriver en tabulatur ar det viktigaste att forsta sig pa takter och olika langder av noter.

For att kunna komponera trummor behdver man ocksa férsta hur man spelar trummor.
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Man behdver inte vara en bra trummis, men man bor veta hur olika trumkomp &r
uppbyggda och hur man komponerar trummor. | Guitar Pro 5 skapar man ett trumspar
med “Track>Add...” och viljer som typ ”Percussion”. For trummorna betyder de olika
numreringarna (som tabulaturen byggs upp av) olika trummor, symbaler och
slaginstrument, och man kan se en lista 6ver alla med ”View>Percussion”. De som
anvands i denna musikproduktion &r foljande:

e 36 — bastrumma

e 40— virveltrumma

o 47,45, 43, 41 — 4 st tom-tom trummor, fran hoga till laga

e 46, 42, 44 — 6ppen hi-hat, stdngd hi-hat och hi-hat pedal

e 53,51 —ride bell, ride

e 57,49 -2 st symbaler, fran hoga till 1aga

e 55 —splash symbal

e 52 —china symbal

5755155155554 52—-51-5146—44—51-52-51 5T—5+-5+5151-5146—44 §2—5+—51+—55—5+5¢

45-45-43-43
40 40 40 40 40

PO MO ML PILT 6 Bl

Figur 4. Tabulatur for MIDI trummor i Guitar Pro 5

De vanligaste funktionerna man bor veta da man skapar trummorna &r hur man byter
taktart, notlangd och tempo. Man hittar allting i huvudmenyn och dessutom finns det
snabbknappar under huvudmenyn till storsta delen av funktionerna, om inte till alla.
Taktart hittar man under “Bar>Time Signature...”, notldngd under "Note>Duration” och

tempo under ”Sound” dédr om ocksa hittar metronom.

Efter att ha komponerat MIDI trumsparet med Guitar Pro ska man exportera det till en
.mid fil som ska importeras till Reaper. Fore importeringen ska man skapa spar for
Ezdrummer vart .mid filen kommer att vara. Det galler att skapa sparet i Reaper med

”Insert>Virtual instrument on new track funktionen”. P& detta vis far man alla virtuella
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trum-mikrofoner pa enskilda spar, vilket man vill ha for att lattare kunna justera pa dem
enskilt. Efter att ha gjort detta kan man importera .mid

[ Trict Qi vric2 B 7z T
filen pa Ezdrummer mastersparet. Sedan ska man ga till v | Tkl
Ezdrummers mixer genom att trycka pa Open Mixer” I Trk2
och vilja ”Multichannel” genom att higerklicka pé t.ex. = 1::3
forsta sparet. Med denna funktion byts utgangen sa att det : e
gar till alla trumspar istallet for att de spelas pa ett spar, Trk 6
dvs. forst da aktiveras de enskilda trumsparen (Youtube Trk7
2012¢). Ui
Stereo
| Multichannel

Figur 5. "Multichannel ” valméjlighet

Tempo- och taktkartan sétts upp i samband med att .mid filen fér trummorna
importeras. Reaper klarar av att 1agga tempo- och taktkartan automatiskt med hjélp av
informationen i .mid filen, men ibland kan det ske misstag som man sjélv maste
korrigera. Da galler det att veta hur tempo- och taktkartan borde se ut och flytta pa
markdérerna for taktbyten sa att de teoretiskt ar i korrekt position. Det brukar vara
markorer for taktbyten som &r missplacerade ifall ndgot inte staimmer.

Om man sjalv vill lagga till tempo-

(7)130. 474 (T)130. 3/4 (T)130. 4/4

och taktbyten gar det att géra med 48.1.00 49.1.00 52.1.00
1-:24 461 1:26.307 1:30.461

”Insert>Tempo signature/tempo

change maker”.

Figur 6. Tempo- och taktkarta fér MIDI filr
Om man inte vill komponera sina egna trummor kan man anvanda Ezdrummers egna
fardiga trumkomp for att bygga sitt trumspar. De hittar man under ”Open Grooves”
sektionen i Ezdrummer, varifran det gar att dra och sldppa olika komp till tidslinjen. Det
kan uppsta problem med att dra och slappa om UAC (kontroll av anvandarkonto) regler
hindrar importering av dessa .mid filer till tidslinjen. Problemet gar att I[6sa med att

Oppna Reaper som administrator (Toontrack FAQ).
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2.3.4 Uppsattning av datorsyntar

Lika som med datortrummorna skapas datorsyntarna forst i Guitar Pro som tablatur. Da
man skriver tabulatur for synt kan man tanka pa hur det spelas med en gitarr och skriva
det som at en gitarr, men dnda anvanda det for synt. Om man véljer att skriva for en 6-
strangad gitarr har tabulaturen 6 stycken linjer som representerar strangarna, da lagsta
linjen ar den tjockaste strangen. De siffror man lagger in representerar bandet pa
gitarren, da 0 betyder 6ppen strang, 1 betyder forsta band, osv. Med val av linjen och

numreringen kan man vélja vilken strang och vilket band som spelas.

Figur 7. Skillnad pa enskilda noter (vénster) och ackord (hdger)

e
J
4
N

—_—
— LSS
—_— e

L-den

Lika som ndr man skapar datortrummorna ska man anvénda sig av taktarter och
tonlangder, men taktarterna ar samma som for trumsparen. Darfor lonar det sig att ha
bade trummorna och syntarna i samma Guitar Pro projekt pa olika spar sa man sakert
har samma takt- och tempokarta. Efter att ha skapat MIDI filen hdmtar man den till
Reaper via att skapa ett spar med Insert virtual instrument on new track”. Sedan i

Reaper bér man anvénda sig av en VSTi for att skapa soundet till .mid filen.

Det finns massor med olika virtuella syntar man kan ladda fran internet. I denna
musikproduktion anvands slutligen fyra syntar som ar pa enskilda spar. Till gitarren och
basens inspelningsskede anvands tva syntar med TyrelIN6 v.3.0 VSTi for att skapa
soundet. | detta skede valjs forinstallda sound som &r liknande till hur de ska slutligen
lata och det slutliga soundet justeras forst i mixningsskedet. Da tillaggs ocksa resten av
syntarna. Syntarna ar i inspelningsskedet med for att vagleda och stéda bandningen av
gitarr och bas. Givetvis behdver syntarna ju inte &nnu vara med ifall de inte behdvs.
Detta &r bara ett exempel hur man kan gora och hur som gjorts i denna

musikproduktion.
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3 INSPELNING

Att banda med VST skiljer sig inte drastiskt fran att banda traditionellt. En fordel med
att banda med VST &r att man kan helt och hallet justera pa soundet efter att man har
bandat. VVanligen géller det ju att stalla in alla instalIningar for soundet man vill banda
men eftersom det anvands pluginner sa gar det att stalla in soundet nar man vill. Det gar
da alltsd annu i mixningsskedet att justera pa soundet, vilket tar bort trycket for att hitta
det ratta soundet redan vid inspelningen. Med anvéndning av VST undviker man
mickning av forstarkare och det gar latt att aterfa samma sound nar som helst. | detta
fall da bara gitarr och bas bandas med riktiga instrument I6nar det sig att marka eller
skriva upp ingdngsnivan man anvander vid inspelning. For att underlatta saker lonar det
sig att banda gitarr och bas med enskilda ingangar sa behéver man inte justera pa
nivaerna da instrumentet byts. Tack vare enkelheten av detta kan man latt aven i
mixnings- eller mastringsskedet komma tillbaka och banda nagot, ifall det finns behov

for detta, och anda aterfd samma sound och niva.

Det ar viktigt att stalla in en bra ingangsniva fran forsta borjan. Da man stéller
ingangsnivan for ett instrument galler det att ha mastervolymen och instrumentsparets
volym i nollage. Forstarkningskontrollen (gain/trim) pa ljudinterfacet ska man ha till
borjan pa det minsta. Sedan galler det att stalla en bra ingangssignal med att vrida pa
forstarkningskontrollen tills signalen har hojts till ett [ampligt lage. Ett lampligt 14ge ar
sadant som har huvudutrymme sa att ljudet inte klipper vid hégre toppar. Signal ska
anda vara tillrackligt hog for att fa en bra volymniva (Strong 2014 s. 142). Da man
bandar instrument galler det att satta instrumentstallning pa sitt ljudinterface till det som
instrumentet &r menat for. Till Focusrite Scarlett 2i2 &r alternativen line och instrument.
Line positionen ar i allmanhet menat for mikrofoner som har nagonslags for-
forstarkning eftersom line positionen ger bara inom ~ 2 millivolts forstarkning
(Maningo 2012). Instrument positionen ar meningen for instrument utan forforstarkning
och ger darfor mer forstarkning. Detta kan dven uppsta till problem ifall den ger t.o.m.
for mycket forstarkning &n vad som behovs, vilket kan minsann ske med Focusrite
Scarlett 2i2 (Reddit Forum 2014b). Man vill inte att ingangsignalen slar pa rott och
darfor ska man da lagga till sa liten forstarkning som mojligt med forstarknings-

kontrollen. Om det inte I6ser problemet kan man alternativt anvanda line positionen ifall
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man har aktiva mikrofoner i sitt instrument som ger minst 1,75V (Maningo 2012). Man
kan ocksa skruva ner mickarna pa instrumentet och anvéanda instrument positionen pa
ljudinterfacet, bara det inte paverkar soundet rejalt. Jag skruvade sjalv ner lite pa
mickarna vilket I6ste problemet for mig, fastén jag tror att det skulle ha varit lattast att

anvanda line positionen for aktiva mickar sa som det tydligen ocksa &r menat.

Fore inspelning av gitarr och bas kan det vara bra att banda trummorna och syntarna pa
nya spar sa att dess ljudpluginner inte behover vara aktiva, vilket befriar processorkraft.
Detta betyder alltsa att trummornas och syntarnas VSTi (virtuella instrument) behover
inte langre vara i anvandning eftersom de ar bandade pa nya spar. | Reaper gor man det
pa foljande satt: man skapar ett eller flera nya spar for det virtuella instrumentet,
beroende pa hur manga spar det behéver. Det nya sparets inspelningsinstéllning byter
man via att hogerklicka pa sparets ”Record Armed” knapp dar man hittar Record:

output” valmenyn. Sen véljer man en lamplig instéllning for sitt &ndamal. ”Record:

output (mUItIChanneD” Record: output (multichannel, latency compensated)
eller ”-(stereo)” bada Record: output (multichannel)
fungerar for att banda t.ex. Record: output (stereo, latency compensated)

Record: output (stereo)

trummorna pa ett eller
Record: output (mono, latency compensated)

flera nya spar. Record: output (mono)
Record: output (MIDI)

Figur 8. ”Record: output” valmeny

Fore inspelning bor man stélla in sand och retur ratt for att sparen skickas och bandas
till de rétta nya spar. Det &r meningen att det som ska bandas skickas som en séand till
det nya tomma sparet och pa detta vis kan man valja vilka spar som ar kopplade till
vilka spar. Man ska undvika att anvanda Ezdrummer mastersparet i detta skede och
anvanda alla enskilda trumspar for att banda trummorna. Da man bandar trummorna kan
man gora ett eller flera nya spar for trummorna, men ifall man i fortsattningen vill
justera pa enskilda trumspar ska man banda de till flera spar. Man kan ocksa banda allt
pa ett spar om man bara behover ett tillfalligt trumspar under inspelning av t.ex. gitarr
for att frigora processorkraft. Men ifall detta ar den slutliga gangen man vill banda
antingen trummorna eller syntarna bor man kolla ocksa andra justeringar som det gar
inte att byta efter att det ar bandat.
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3.1 Datortrummor

Som sagt sa lonar det sig att banda trummorna pa nya spar, istallet for att ha Ezdrummer
aktiverad genom hela inspelnings- och mixningsprocessen. Med andra ord sa vill man
forandra MIDI sparen med VST ljudpluginnerna till WAV filer. Fére man bandar sa
galler det da att se till att allt Iater s& som det ska fore effekter. Ovriga justeringar, sa
som EQ och reverb, behéver man inte &n stélla in eftersom man kan goéra det till de
bandade sparen. Det galler &nda att justera vissa saker som man inte senare kan &ndra pa

efter att trummorna ar bandade utan att banda pa nytt.

3.1.1 Sampling

Om inte Ezdrummer har att erbjuda rétt slags sound man ar ute efter, for t.ex. bas- eller
virveltrumman, kan man ersatta dem med ett eget sampel (majligtvis nerladdad fran
internet). FOr trummorna i denna musikproduktion ersatts bas- och virveltrumman med
Reapers egna ReaSamplOmatic5000. Man ersatter den efterstravade trumman med att
stillla in tonomrédet med ”Note start” och “Note end” knapparna tills det ratta omradet
hittas. Dessutom ar det viktigt att sedan sanka volymen pa den gamla sampeln i
Ezdrummer ifall man inte vill att den ar horbar. Har &r ett exempel pa installningar (som
anvands i denna musikproduktion) for att ersatta Ezdrummers virveltrumma med eget

sampel:
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ReaSamplOmatic5000

44100Hz 2ch 0.70s

'
iew start: 0.00s, size: 0.70s, 64.3 splpix Start: 0.00s, Length: 0.70

[btass-sd wav v ] .

Mode: [Sample (lgnores MIDI note) vH Import item from amange ] [ Browse... ] [ flist] ]

Volume: () -11.2 dB  Velocity maximum: (') 127 Pan: (\) 0.50
Minvol: () -60.0 dB Velocity minimum: (') 0
Note start: (©) 40 E2 Sitch@start: () {80
Note end: (- ) 38 D2 Pitch@end:. (') (39
Pitch offset (') 0.00 semitones  Pitchbend: (') 20  semitones (maximum)
Attack: () 1.00 ms Sustain: () +00 dB  Decay: (U 250 ms
Release: () 114 mg || Note-off release ovenide: (') 1 ms
MIDIChan: (') 0 (0=all) Max voices: () 1
Probability: (') 100 [ |Round+obin [ | Remove played notes from FX chain MIDI stream
|¥|Obey noteoffs | |Loop Xfade: (') 000 ms  Loopstart offset: (') 0.00 ms
Resample mode: [(project default) v] Cai‘;“‘:r?ﬁ;s: 64 MB

Figur 9. Instéllningar for ersattning av virveltrumma med ReaSamplOmatic5000

Forst giéller det att importera samplet man vill anvinda, 1 detta fall ”brass-sd.wav”. |
”Mode” valmenyn ska man vélja ”Sample (Ignores MIDI note)” for detta &ndamal.
”Attack” justerar hur snabbt sampeln borjar med full volym och “Release” justerar nér
den borjar tona bort. Man kan justera dessa ocksa i spektrumet da A ar ”Attack”, R ar
”Release” och D dr hur brant kurvan ligger. ”Velocity maximum” och ”-minimum”
fungerar lite som volymkontrollen men de har inte anviands i detta projekt. Ovriga

funktioner har inte behdvts for att sampla datortrummorna.

3.1.2 Humanisering

Humanisering dr ett viktigt steg for att ge mer variation till datortrummorna som annars

later livlosa. Man behover inte humanisera hela trumsetet pa samma gang, utan man kan

t.ex. humanisera tom-tom trummor skilt med egna installningar om det later battre sa.

Med att humanisera datortrummorna menas det att skapa variation till datortrummorna, i
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form av volymvariation och t.0.m. sma variationer i timingen. Jag kom pa att med

ReaSamplOmatic5000 kan man humanisera de nya samplen, t.ex. virveltrumman, med

att skapa volymskillnad mellan trumslag. Det gér man med att gora en dubbling av

samma sampler men sinka volymen och dndra Probability” till t.ex. 80. Detta gor att

med 80% sannolikhet fungerar den nya samplern som ger en liten volymforhjning och

da den inte fungerar &r slaget lite saktare. Det gor alltsa att slaget ar ibland svagare,

beroende pa vilken volymskillnad och sannolikhet man stéller in. Detta satt ger anda

kanske inte tillrackligt variation, och for att skapa mer variation borde man ha flera

samplers med olika sannolikheter. Denna metod &r nog inte den smartaste och basta for

det och som tur finns det béttre satt. I Ezdrummer finns “Humanize” funktionen som

gor datortrummorna mindre mekanisk latande och mer mannisko-lik. Man kan justera

pa denna funktionen med “Velocity” knappen. Detta gor att t.ex. alla virveltrumslag inte

ar av samma volym och av samma ton vilket gor

att det later mera manskligt.

Figur 10. Humaniserings funktion i Ezdrummer

Samma sak kan man gora direkt till MIDI sparet vilket ger fler alternativ. Genom att

dubbelklicka pd MIDI objektet pa dess spar i Reaper och ga till ”View>Humanize” i

9% 9y

MIDI editeringsrutan far man tre justerbara funktioner: *Timing”, Velocity” och

”Timing Bias”. Dessutom kan man vélja om dndringarna sker till alla MIDI noter eller

sa kan man sjélv vilka noter som paverkas. ”Timing” dndrar pa timingen for noterna

vilket ar en bra funktion for att f& trummorna att lata mera mannisko-lik eftersom man

kanske inte vill att trummorna spelar 100% i takt med metronomen hela tiden. Stora

forandringar vill man kanske inte heller gora s att trummorna léter otajt. ”Velocity”

fungerar pa samma sitt som i Ezdrummer, dvs. justerar pa volymnivaerna. ”Timing

Bias” dr en finjustering for “timing”
som flyttar pa noterna jamnt bakat
eller framat i tiden. Dessutom finns
”New random seed” knappen som
randomiserar pa nytt alla
volymforandringar och

tidsforsjutningar fér noterna.

Humanize Notes 3 18 @

Q@ All Notes (1 Selected Notes

Timing: L ‘[ : 8 %
| <
| 35 %

Velocity: R,

Timing bias: 3 0 %

New random seed 0K ' [ Cancel ]

Figur 11. ”Humanizing notes” valmenyn i MIDI editeringsrutan
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Det gar ocksa manuellt att justera pa noternas volym och timing och ﬁ
pa de viset far man de precis hur man vill, men det ar ratt el
tidskravande. Det gor man med att véalja MIDI noten man vill justera
och dra uppat eller nerat for att justera volym eller at sidorna for att

tidsforskjuta noten. = =

h

Att humanisera i MIDI editeringsrutan &r det mangsidigaste och mest
justerbara alternativet for att skapa variation till datortrummorna. Att
humanisera i Ezdrummer ar det enklaste alternativet med vad man

anda far bra resultat, ifall dess variation racker till for det man vill ha

och man anvander inte egna samplar (Ezdrummers humanisering

Figur 12. S&nkning i volym av en vald not i MIDI editersingsrutan

paverkar inte egna samplar som &r via ReaSamplOmatic5000). I

3.1.3 Panorering och volym i Ezdrummers mixer

Fastan man valjer trumsparen som “multichannel” kommer tom-tom trummorna att
bandas till samma spar. Orsaken till detta &r att det finns en begransad mangd av spar i
Ezdrummers mixer och det gar inte att lagga till, bara att ordna pa nytt, och i detta fall ar
alla tom-tom trummor pd samma spar. Darfor ska man i Ezdrummers mixer panorera
tom-tom trummorna s& som man vill och justera eventuella volymskillnader mellan
dem. Ovriga trummor lénar det sig att ha volymen vid nollige och panorerat i mitten
eftersom de kan man justera pa efter de har bandats.

3.2 Datorsyntar

Efter att man har hittat en passlig mjukvarusynt och stéllt in soundet pa den sa som man
vill, kan det vara bra att géra samma som med datortrummorna och banda syntarna till
ett annat spar. Det ar mycket mojligt att man vill gora detta forst i mixningsskedet (se
delkapitel 4.7) efter att man justerat sound till de andra instrumenten, ifall man vill
tillsatta synten sist. | varje fall sa fungerar inspelningsprocessen pa samma satt som for

datortrummorna. Om man inte har en hel del synt under hela laten ar det battre att banda
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bara de stéllen var det ar synt. Pa detta vis blir det mindre filstorlekar &n om man skulle

banda hela latens langd med massor av pauser pa synt sparen.

3.3 Allmannainspelningsmetoder

For att spara tid vid inspelningen l6nar det sig att skapa reservspar for det man bandar.
Da man bandat en ok tagning, men vill anda prova att fa en béttre tagning, kan man
satta tagningen till reservsparet och anvanda det senare ifall det finns behov. Det kan
spara tid i fortsattningen. Ifall nagon tagning ar annars bra forutom nagot visst stélle
som skulle kunna vara battre finns det nagra alternativ man kan géra:

e Banda pa nytt hela sekvensen.

e Anvand punch-in funktion och banda bara 6ver specifika stallet.

e Se om samma stélle &r bra i ndgon annan tagning som sparats till reservsparet.
De tva senare alternativen sparar sannolikt tid och anvands darfor i denna
musikproduktion. | Reaper kan man vélja punch-in metoden med att vélja det i
”Options> Record mode: time selection auto punch”. Fére man bandar ska man da géra
ett tids urval som man gor med att mala omradet med musen. Markoren ska ligga dar
man vill att det ska borja banda. ”Record mode: auto-punch selected items” fungerar pa
samma satt som ”-time selection auto punch”, men istéllet for att gora ett tids urval
valjer man objekten man vill banda éver. Pa de viset kan man i samma
bandningstillfalle ocksa banda flera olika

Record mode: normal

sektioner som inte ar direkt fast i : ;
v Record mode: time selection auto punch

varandra med att vdlja flera objekt. Record mode: auto-punch selected items

Figur 13. “Record mode ” valmeny

3.3.1 Gitarr

Ifall man vill ha tva gitarrspar panorerade vill man antagligen hora gitarrsparen sa
tydligt som mojligt da man bandar for att spela in dem sa tajt som majligt. En bra metod
ar att ha gitarrsparen pa solo sa att man inte hor andra instrument da man ska dubbla det
andra gitarrsparet. Redan i detta skede &r det bra att panorera gitarrsparen, t.ex. 40 %, sa
att man hor tydligare de enskilda sparen. Att ha metronom ar ocksa rekommenderat,

antaget att allting ar i takt. Pa detta vis hor man tydligt da gitarrsparen synkar bra ihop.
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3.3.2 Bas

Som en gitarrist kan man vara ovan att banda bas. Viktiga saker att justera fore
inspelning ar &r tonknapparna pa basen. Om man inte vet riktigt vad &r ett bra sound for
rasignalen l6nar det sig att stalla in ett ganska neutralt sound. Inte for mycket av nagot,
t.ex. bas eller treble, men anda sa att det finns i soundet da man vill borja justera det
med pluginner. Om soundet innehaller bara lite bas kan det vara svart att senare férsoka
tillsatta bas med hjalp av pluginner om inte det redan finns i rasignalen. Man ska ocksa
tanka pa om man véljer att anvanda ett plektrum eller att spela med fingrarna. For en
gitarrist som &r ovan bassist kan plektrum vara ett bekvamare alternativ, i alla fall om
laten & mer kravande. Det spelar ocksa stor roll i vilket position man slar pa strangarna,
dvs. hur langt eller nara ifran strangstallet slagen slas. Tonen av slagen paverkas
mycket, s& man ska vara medveten om hurdant sound man vill ha och hur man ska fa
det.

4  MIXNING

4.1 Allmanna mixningsmetoder

Forst och framst dr det en bra idé att stalla in alla spars volymnivaer sa att man far en
béttre bild av hur allt later vid detta skede, sa att alla instrument ar horbara. | detta skede
kan man ocksa panorera instrumenten. Hogst troligen &r justeringarna inte slutliga och

det &r bara att aterjustera nar man vill.

4.1.1 Frekvensspektrumet och ekvalisering

En bra utgangspunkt da man mixar ar att forsoka tacka frekvensspektrumet med
instrumenten utan att de dverlappar varandra allt for mycket, sa att olika instrument
skater olika frekvensomraden. Pa detta satt skapar man klarhet i helheten och man hor
och skiljer at alla instrument béttre (Strong 2014 s. 250-251). Det I6nar sig att klippa
bort sadana frekvenser som instrumentet inte behdver och pa de viset ge utrymme at
andra instrument (Crich 2010 s. 247).

26



4.1.2 Sand/retur effekter och gruppering

Idén med sand/retur effekter ar att skapa ett spar for en effekt, t.ex. for reverb, som
sedan andra spar kan vara i kontakt med, t.ex. virveltrumman. Med denna metod gar det
ocksa latt att kontrollera volymen av effekten och justera pa nivan i olika skeden av

laten vid behov med anviindning av “Track>Envelopes” (se delkapitel 4.1.5).

Om man vill gruppera flera spar gar det enkelt att gora i Reaper. Man gor ett nytt spar
ovanfor sparen som ska vara med i gruppen och trycker pa folder ikonen i sparets hogra
nedrehdrn som sedan placerar alla nedanstaende spar till denna delgrupp. Det sista
sparet man vill ha med i gruppen véljer man med att dubbelklicka pa sparets folder ikon.

4.1.3 Fasfel och korrelation

Med t.ex. Voxengo SPAN ljudpluginnen kan man analysera bl.a. ljudets
frekvensspektrum, DBFS samt RMS peak och faskorrelation. | denna musikproduktion
anvands tva pluginner for att forsoka fixa fasfel: preF1X av Variety Of Sound och
PhaseBug av BetabugsAudio. Det hittades tva ljudpluginner som orsakar andring i fas
korrelationen: NUSofting DeepBoard akustisk simulator och Ozzifier Chorus effekt.
Ozzifier Chorus effekten andrar pa faskorrelationen men métaren halls énda pa positiva
varden, vilket betyder att andringen inte &r kritisk. Dessutom &r soundet av
ljudpluginnen 6nskat sa ingen korrektion behdvs. NUSofting DeepBoard skapar enligt
korrelationsmataren fasfel, dvs. negativa varden i korrelationen, och problemet har
forsokts fixas (se delkapitel 4.4.4).

4.1.4 Effektkedja

Det finns inga regler till hurdan en effektkedjas ordning av ljudpluginner bor vara
eftersom olika ordningar skapar olika effekter och man kanske vill att det beter sig pa
nat visst satt. Den grundlaggande idén for gitarrens och basens effektkedja i denna
musikproduktion ser ut som foljande:
forstarkare>impulsrespons>EQ>kompression>effekter (t.ex. chorus)>delay>reverb.
Ifall man anvénder distortion behdvs kompression inte nédvandigtvis eftersom
distortionen redan komprimerar signalen till en viss grad (Heduiska). Delay och reverb
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sétts efter kompressionen av den orsaken att delayn och reverbet inte ska komprimeras,
utan dess effekt passar béattre efter den komprimerade signalen. Reverbet satts efter
delayn av den orsaken att delayn ska repetera signalen utan nagon tidsbaserad effekt,
och sedan paverkar reverbet signalen med delayn. Undantag har gjorts da delay effekter
har ett eget spar, alltsa reverbet kommer fore delayn da reverbet ligger pa sparet som
skickas till delay spéret. Ovriga effekter, s3 som chorus och phaser, sétts efter
kompressionen for att inte komprimera effekten. Viktigast ar att man gor det som later
bést for det man ar ute efter och pa det viset gor undantag i sina egna regler man kanske
har eller det som rekommenderas. Skillnaderna kan vara knappt horbara sa man ska inte
fastna for mycket i det heller.

4.1.5 Panorering och volym

Man ska saklart justera volymnivaer och panorering sa som man vill att det ska lata och
troligen vill man att allting ar horbart. Med reverb och delay kan man ytterligare skapa
bilden av om nagot ar framme eller bakom i mixen (Strong 2014 s. 268). Man kan ocksa
breda ut stereoféltet for ett spar med t.ex. Stereo Enhancer ljudpluginnen och med en
goniometer kan man se hur det paverkar stereofaltet. Ifall man vill géra en speciell
panorering gar det att gora i Reaper med “Toggle pan visible” i valmenyn for spérets
”Track>Envelopes”. For ”Phaser gtr”” och ”Solo phaser” gjordes sddan slags panorering
dar ljudet vandrar mellan vanstra och hogra utgangen. Pa liknande sétt kan man ocksa
justera pa volymen med “Toggle volume visible”, d& man kan héja och sénka pa
ljudnivan sa som man vill i olika skeden av laten. Pa detta vis kan man ocksa justera pa

en effekt som ligger pa ett skilt spar.

4.2 VST forstarkare

VST forstarkare ar bland de viktigaste elementen for att forma soundet till gitarr och
bas. Efter rasignalen &r det forstarkaren som bestammer hur soundet karaktariseras.
VST forstarkarens princip och anvandbarhet &r samma som med en riktig forstarkare.

Detta betyder anda inte att VST forstarkare ar lika kompetenta som analoga forstarkare.
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Att fa ett bra sound med att enbart anvanda en VST forstarkare kan vara svart, speciellt
for distad gitarr. Distad gitarr enbart med VST forstarkare later latt for digitalt, torrt och
tunt. For att ge varme och fyllighet till soundet ar det en god idé att anvanda impuls-
responser i samband med forstarkaren. FOr bas och ren gitarr ar det lattare att justera ett
bra sound enbart med VST forstarkare men &ven for dessa kan anvandning av impuls-
responser forbattra soundet betydligt.

4.3 IR —Impulsrespons

Impulsresponser kan anvéndas for t.ex. gitarr for att skapa ett mer ”akta” sound. IR &ar
inte bara en forstarkare simulator som lagger pa ett EQ filter, utan IR har djupare
karaktariserad sound vilket innebar detaljer av akustik, mickning, hogtalare och skap av
nagon specifik modell och sammanséttning (Thorn 2012). IR &r inte distortion eller
kompression, utan det &r frekvens- och fasrespons, reflektioner och andra faktorer ur
t.ex. ett hogtalarskap, allt i en kort signal som kallas for en impuls (Grabinski 2012).
Det finns massor med impulsresponser det gar att ladda och tillampa for sin gitarr och
bas. | denna musikproduktion anvands ljudpluginnerna Convolution amp/Amp modeler

och Poulin LeCab2 for att tillampa impulsresponser for gitarrer och bas.

4.4 Gitarr

Tabell 1. Alla spar for gitarr

Namn i projekt |Betydelse

”Clean gtr 17 Ren gitarr panorerad 45% till vanster
”Clean gtr 2” Ren gitarr panorerad 45% till hoger
’Clean solo” Ren solo gitarr i mitten

”Cl solo hrm” Ren solo gitarr i mitten saktare i volym
”Phaser gtr” Distad gitarr med phaser effekt

”Main gtr 17 Distad gitarr panorerad 45% till vanster
”Main gtr 2” Distad gitarr panorerad 45% till hoger
”Solo phaser” Distad solo gitarr med phaser effekt
”Solo gtr” Distad solo gitarr i mitten
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”Solo gtr hrm” Distad solo gitarr i mitten tystare i volym
”Solo L” Distad solo gitarr panorerad 45% till vanster
”Solo R” Distad solo gitarr panorerad 45% till hoger
“Dly L&R” Delay spar for ”Solo L” och ”Solo R”

441 VST forstarkare

For rena rytmgitarrerna (“Clean gtr 1 & 2””) anvands LePou LeXtac VST
gitarrforstarkare. Det ger mera presens at gitarrtonen och anvands som ett bra botten at
tonen for vidare justering. Som sadan ar gitarrtonen inte imponerande men funkar bra
tillsammans med de andra justeringarna. For de tva rena sologitarrsparen (“Clean solo”
och “Cl solo hrm”) anvidnds samma VST forstirkare som for rena rytmgitarrerna, fastan
de later mycket olika pga. andra justeringar. For alla distade gitarrer anvands LeGion av
LePou som later som sadan mycket tunn, torr och digitalisk, men tillsammans med

impulsresponser far man ett bra sound.

442 IR

For de rena sologitarrsparen placeras en IR efter forstarkaren med Convolution
Amp/Cab Modeler vilket ger mera botten at soundet och later mera som att det skulle
komma ur en riktig forstarkare. Alla distade gitarrer har samma instéllningar da det &r
fraga om impulsresponser. Forsta impulsresponserna, som i detta fall &r blandat av tva
IR med Poulin LeCab 2 pluginnen, ar placerad i borjan av hela effektkedjan, alltsa fore
forstarkaren. Orsaken till detta ar att effekten av IR blir mycket liten pa detta vis men
passlig for det sound som sokts for gitarren. Det hamtar en nyans som &ar knappt
mérkbar men passlig med den andra IR som kommer efter forstarkaren. |1 LeCab 2 kan
man hamta 6 stycken olika impulsresponser som gar att blanda ihop for att skapa nya
sound. En annan impulsrespons ar placerad efter den virtuella gitarrforstarkaren med
pluginnen Convolution Amp/Cab Modeler. Denna IR har stérre effekt pa soundet och
spelar storre roll. 1dén av placeringen av forsta IR fore forstarkaren kom genom att

prova och det visade sig att vara ett lampligt val for finjustering av soundet.

30



4.4.3 Ekvalisering

De distade rytmgitarrerna har en EQ justering som komplimerar basen, dvs. vissa
frekvensomraden som &r forstarkta pa basen ar minskade pa gitarren. Pa de viset hor
man béade basen och gitarren tydligare tillsammans eftersom gitarren ger utrymme for
basen (Crich 2010 s. 245). Ekvaliseringen for rena gitarrerna ger ett klarare sound med
hojningen pa mid frekvenser, speciellt vid 1200-1700 Hz. Distade sologitarrerna har
olik ekvalisering an rytmgitarrerna for att skilja dem battre at. Rena sologitarrerna har
ocksa olik ekvalisering an rena rytmgitarrerna av samma orsak. Rena och distade
sologitarrerna har en forhdjning kring 3 kHz — 8 kHz men forhéjningarna &r inte
identiska.

4.4.4 Effekter

For de rena rytmgitarrerna anvands en akustisk simulator ljudplugin som heter
NUSofting DeepBoard, som placeras efter forstarkaren. Sounden av Deepboard &r bra
och man far en mer akustisk lik ton, vilket &r meningen med en akustisk simulator.
DeepBoard orsakar dock fasfel som inte later direkt stérande men kan vara vart att
forsoka minska pa. | detta fall borde man lita mera pa sina 6ron och lyssna om det later
bra &n att bara lita pa korrelationsmataren eftersom effekten tydligen ar sadan som
orsakar fasfel. Ljudpluginnen ger anda ett 6nskat sound och darfor anvéands den. Jag
lyckades minska pa fasfelet men fick inte det eliminerat helt och héllet. Enligt
korrelationsmataren forekommer det mer séallan negativa vérden efter korrigeringen som
gjordes men pa samma sa ar vardet mera mot det neutrala an ursprungligen, da det
hoppade starkt mellan hoga negativa och positiva varden. Det beror ocksa pa i vilket
skede av laten man mater eftersom det beter sig olikt i olika stallen. Detta gjordes med
bade preF1X av Variety Of Sound och PhaseBug av BetabugsAudio. Med preFIX bl.a.
inverterades fasen och med PhaseBug justerades fasen skilt for véanstra och hdgra
kanalen av sparet. Genom att prova pa olika installningar valde jag det som fungerade
bést. Slutresultatet blev battre an med utan faskorrigeringen: nu gar laten inte pa

negativa varden vid introt som det gjorde fore korrigeringen.

Ovriga effekter for ”Clean gtr 1 & 2” #r delay och reverb som ar ocksa tillsatta for de

andra gitarrsparen. For ”Solo L & R” gjordes ett eget delayspar ("Dly L&R”) som
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skapades JS: Delay som &r en standard effekt i Reaper. Orsaken till att det &r pa ett eget
spar ar for att kunna justera volymen for effekten olikt i specifika skeden av laten. T.ex.
effekten ar i slutet av laten ca 10 dB hardare an vad den &r i borjan. Ozzifier Chorus
anvands pa distade gitarrerna med 25 % effekt for att ge knappt horbar chorus effekt.
”Phaser gtr”” och ’Solo phaser” anviander 4-Tap Phaser ljudpluginnen som ar placerade
efter choruset.

4.45 Kompression

Rena gitarrerna har kompression for att framhéava alla toner tydligare, speciellt rena
sologitarren som har stark kompression. Distade rytmgitarrerna har ingen kompression
medan distade sologitarrerna har for att eliminera toppar.

45 Bas

I denna musikproduktion finns det tva olika baser: en mjukare som férekommer i introt
och outrot av laten och en som ar hardare med lite distortion som forekommer i

huvuddelen av laten. Basernas ton ar olik till varann for att passa battre till laten.

Tabell 2. Alla spar for bas

Namn i projekt |Betydelse

”Bass Gtr” Mijuk bas till intro och outro av laten
“Bass 2” Hard bas till huvuddelen av laten
”Bass Dist” Distortion till "Bass 2”

45.1 VST forstarkare

For ”Bass Gtr” anvénds Ignite Amps SHB-1 VST basforstarkare och for ”Bass 27
anvands Bass Preamp v. 1 av Rolando Passion. Bass Preamp v. 1 later lite tjockare och
darfor passar den battre i huvuddelen av laten. Ifall man vill lagga distortion pa basen
I6nar det sig att skapa ett nytt spar for det. Pa detta vis kan man latt kontrollera hur man
vill blanda basen med distortionen eftersom bada har egna volymreglage. Som

distortion for ”Bass 2”” anvands Metal Clone av Mokafix Audio.
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452 IR

For bada baserna anvands Convolution Amp/Cab Modeler for att hamta
impulsresponser. Mjuka och harda basen har olika impulsresponser i anvandning, valt
enligt det som passar battre dem. Impulsresponserna anvénds som ett ytterligare sétt att

ge mer karaktar till soundet for baserna.

4.5.3 Ekvalisering

For att 3 ett bittre sound till “Bass gtr” har frekvensomradet 200-300 Hz sankts for att
ta grumlighet bort, forstarkts vid 100-200 Hz att inte basen later platt och forstarkts vid
2,5-5 kHz for att fa attack. Dessa omraden ar rekommenderade att justera pa ifall man
inte ar nojd med soundet (Strong 2014 s. 262). Det &r ocksa viktigt att tanka pa gitarrens
och bastrummans frekvensspektrum da man ekvaliserar basen for att fa allting att lata

bra tillsammans (se kapitlen 4.4.3 och 4.6.1).

4.5.4 Effekter

“Bass gtr” anvander Ozzifier Chorus for att skapa en chorus effekt. Samma spar har
ocksa Stereo Enhancer for att breda ut stereoféltet.

455 Kompression

”Bass Gtr” har en tung kompression for att dra ner pa volymen orsakat av
impulsresponsen (fastan det ocksa gar att dra ner pa dB for IR eller for sparet) och for
att skapa en jamnare bas med att minska pa dynamiken for den. For Bass 2” har gjorts
lite samma sak men inte i lika stor grad. Med kompressionen har plétsliga toppar

eliminerats och pa sa satt skapats en jamnare bas.
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4.6 Datortrummor

Tabell 3. Alla spar for datortrummor

Namn i projekt |Betydelse

”BD” Bastrumma

”SN” Virveltrumma, mickad ovan, panorerad 5 % till vanster
verb” Reverb till ”SN”, 5 % panorerad till vinster

”SN2” Virveltrumma, mickad under, panorerad 5 % till vanster
"HH” Hi-hat, panorerad 15 % till vanster

”Toms” Tom tom trummor

”OH” ”Overhang” mickar

”Room” Rumsmikrofoner

”Comp mix” Ezdrummers egna kompressionsspar for trummorna

4.6.1 Ekvalisering

Ett siitt att fi mera “punch” till bastrumman ir att lyfta pa frekvensomradet dar
bastrumman ligger och sanka samma omrade eller lamna det vid nollage pa basen. Pa
detta vis ligger basen inte dar bastrumman ligger och ger mer utrymme fér bastrumman
i sitt frekvensomrade (Crich 2010, s 171). Foljande figurer visar att bastrumman ar
forstarkt vid 50-200 Hz och dessutom vid ca 550-1200 Hz, da basen inte ar forstarkt vid
samma omraden (bara lite frdn 150-200 Hz). Bastrummans attack ligger vid ca 3-6,5
kHz som é&r forstarkt och basen har hojts vid ca 2,7-4,5 kHz men de interfererar inte

anda i stort satt med varandra och later bra tillsammans.
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Figur 14. "Bass 2” ekvalisering

Figur 15. ”"BD” ekvalisering

4.6.2 Effekter

For ”SN1” gjordes ett skilt spar for reverb effekten. P4 ”verb” spéret finns Reapers
ReaVerbate reverb och en ReaGate som anvénds for att ha ytterligare kontroll dver nér

reverbet tonar ut.
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4.6.3 Kompression

For bastrumman och tom-tom trummorna finns kompression for att sénka mycket hdga
slag som forekommer sallan och for virveltrumman finns kompression for att minska pa
dynamiken, men inte sd mycket att humaniseringen forsvinner. ”Comp mix” spéret
spelar inte sa stor betydelse for trummorna, den ger bara en minimalisk forstarkning till
dem eftersom sparet ar justerat ganska lagt i mixen. Om sparet ar justerat hogre kan man
anvéinda den som en forstarkning och dessutom ger den lite kdnslan av ”6ppenhet” till

trummorna.

4.7 Datorsyntar

Synt sparen har bandade ljudfiler av VSTi som anvands for dem, dvs. dessa spar har

inte mjukvarusyntar aktiva som ljudpluginner.

Tabell 4. Alla spar for datorsynt

Namn i projekt |Betydelse

”Choir” Kor-lik synt

”Synth” Klassisk synt lead

”Synth2” Klassisk synt lead utan delay och reverb
”Matnil” Strakorkester-lik synt panorerad 35 % till vanster
”Strings1” Strakorkester-lik synt panorerad 15 % till hdger
”Matni2” Strakorkester-lik synt panorerad 65 % till hdger
”Strings2” Strakorkester-lik synt panorerad 5 % till vanster
4.7.1 VSTi

For ”Choir” anviands ChoirZ mjukvarusynt av DSK. Med ChoirZ kan man stélla in tre
olika syntar som har egna instéllningar och filter, samt chorus och reverb. For ”Synth”
och ”Synth2” anvands TyrelIN6 av u-he som har massor med olika forinstéllda syntar
med mycket justerbart. For "Matni” anvinds Matnitron av SynthEdit som simulerar en
strakorkester. Den har fyra justerbara kontroller: Attack, Decay, Sustain och Release.

For ”Strings” anvénds en liknande mjukvarusynt som heter Section Strings av
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Ensamusic, som har flera justerbara kontroller. Tillsammans funkar ”Matni” och

”Strings” bra med dess olika sound.

4.7.2 Ekvalisering

For ”Choir” ir ca 700 Hz — 5000 Hz frekvensomradet forstarkt for att fa synten
tydligare fram. ”Matnil” och Strings1” har ganska verdriven ekvalisering pa hoga
och lowmid frekvenser sa att de ska sta ut bland gitarrerna. Tillsammans med “Matni2”
och ”Strings2”, som har mildare ekvalisering, fungerar de bra ihop dessutom med de

olika panoreringarna.

4.7.3 Effekter

Effekter som anvinds for ”Choir” och ”Synth” i denna musikproduktion &r reverb och
delay. Man kan forsoka fa synten att lata storre med att tillsétta reverb och delay och
dessutom kan man anvanda Stereo Enhancer som breder ut stereoféltet. ”Synth2” spelar
en snabbare snutt och darfor behdver soundet vara noggrannare, vilket betyder att
reverb och delay ldamnas bort.

4.7.4 Kompression

Syntens dynamik varierar allméant inte mycket och darfor behovs bara lite eller ingen
kompression och i detta fall har de inte nagon kompression (Huber, Reinstein 2010 s.
497).

4.8 Slutfor mixning

Fore man évergar till mastering géller det att kolla om man gjort allting som behovs i
mixningsskedet eftersom mastering paverkar hela musiken och inte enskilda spar. Det
galler att fa redan i mixningsskedet musiken att lata sa bra som majligt. Det I6nar sig att
lyssna pa musiken som mono sa hor man tydligare volymskillnaderna mellan
instrumenten och sa kanske marker man nagot som bor korrigeras (Strong 2014 s. 303-
304). Da man skater om allting sjalv i musikproduktionen, dvs. inspelning, mixning och

mastering, dr det lattare att hoppa tillbaka till dessa steg vid behov for aterjustering.
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4.8.1 Volymniva

Det ar viktigt att se till att det inte sker distortion pa nagot spar. Om det sker kan man
sanka pa alla spar lika mycket sa att man uppratthaller balansen. Ifall det ar nan viss
topp som orsakar distortion i nagot skede av laten Ionar det sig att sanka denna topp.
Det rekommenderas att mastervolymen inte dverskrider -3 dB (peak) sa att det finns
tillrackligt huvudrum foér mastringsprocessen (Music Production Guide). Denna regel
har foljts i denna musikproduktion och hdgsta toppen &r -3,3 dB. Huvudsaken &r att
volymnivan inte dverskrider 0 dB och i sadant fall bara korta toppar av t.ex. trumslag
som inte distar (Big Label Studio), men lika bra kan volymnivan sénkas eftersom den
slutliga volymnivan stélls in i masteringsskedet. Man ska inte heller anvanda en limiter
pa mastersparet for att uppna dessa varden, utan med séankning av alla spar tillsammans

ska volymnivan uppnas. Mastersparets volym &r bra att halla vid nollage.

4.8.2 Rendering

Fore man renderar (alias exporterar) musiken ska man se till att man lamnar minst en
sekund extra utrymme i borjan och slutet av laten, sa att man har rum for att tona in och
ut laten (Music Production Guide). For denna musikproduktion som &r bandad och
mixad i 44,1 kHz samplingsfrekvens och 24 bitar ska man stélla in samma instéllningar
da man renderar. WAV 4r ett bra filformat att rendera i eftersom den &r forlustfri (Sage

Audio). Samma installningar stalls da det renderas efter mastering.

5 MASTERING

Alla justeringar man gor i masteringsskedet paverkar hela laten och ifall man ska géra
nagon justering till ett enskilt spar ska det goras i mixningsskedet. | allmanhet handlar
mastering om ekvalisering, komprimering och justering av ljudnivan. I detta sista steg

av musikproduktionen har soundet finslipats, VST: ReafFir (FFT EQ+Dynamics Proc...
. ) ) ) VST: FemicTDS {x86) (Variety Of Sou...
ljudnivan hojts och musiken framforts tydligare. VST: ReaXcomp (Cockos)

VST: ReaFir (FFT EQ+Dynamics Proc...
VST: Limiter No6 (Madislav Goncharov)

Figur 16. Effektkedja for mastering i denna musikproduktion
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5.1 Ekvalisering

| detta skede kan man justera pa frekvensnivaerna for hela laten eftersom det har blivit
renderat till ett och samma spar. Forsta ekvaliseringen i effektkedjan ar gjord med
Reapers ReaFir som fungerar som ekvalisator, gate och kompressor, men i detta fall
anvands den i EQ laget. Denna ekvalisation gor redan en stor andring i hela soundet for
laten. Det later klarare, tydligare och fylligare pga. att den ar stalld in for att lite jamna

ut frekvensspektrumet. Frekvensomraden som behdver forstarkning eller forsvagning

har justerats.

Figur 17. Forsta ekvaliseringen i masteringsskedet
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En annan ekvalisering har gjorts efter tva kompressorer som foljer forsta ekvalisationen
I effektkedjan. Dess mening &r att finjustera och 6ppna soundet efter kompressorerna.

Figur 18. Andra ekvaliseringen i masteringsskedet

5.2 Dynamik, kompression och limiter

Lika som ekvalisering i masteringsskedet gar det att komprimera och paverka
dynamiken for hela laten. Det I6nar sig att anvanda flera kompressorer med sma
mangder av kompression istéllet for en med stor méngd av kompression, for att undvika
horbara andringar under laten pga. komprimeringen (Strong 2014 s. 309). | denna
musikproduktion anvands tva kompressorer till mastering: Ferric TDS av Variety Of
Sound och ReaXcomp, Reapers egna flerbands kompressor. Ferric TDS, som kommer
efter forsta ekvalisering i effektkedjan, anvander forinstéllda justeringen “Final II”” som
forstarker laten. En liten minskning pa kompressionen har dock gjorts i skillnad till
forinstallningen. Med flerbands kompressorn ReaXcomp har lag-mid frekvenser och
hoga frekvenser komprimerats en aning mera an de andra frekvensomraden for att
minska pa dynamiken i dessa omraden. Slutligen tillsatts en limiter for att ge en sista
forstarkning till ljudnivan for laten. For detta anvands LimiterNo6 av Vladislav
Goncharov med ”Master 6 forinstidllningen. Forinstillningen passar bra till 1aten 1 fraga
men justeringar har anda gjorts: kompressorn inaktiverats pga. det inte finns behov for
den, HF Limit (hogfrekvens limiter) tillsétts for att lite mjuka till hoga ljud och en liten

forstarkning pa Peak Limit Gain har gjorts for att gora laten en grad hardare.
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5.3 Analys

Féljande figurer ar en jamforelse mellan fére och efter mastering av ungefar samma

position i laten. Saklart beror det pa precis vilken millisekund som har fangats, men man

kan med sékerhet sdga att efter mastering har laten blivit forstarkt och jamnare.

Figur 19. Frekvensspektrum analys fére mastering
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Figur 20. Frekvensspektrum analys efter mastring
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6 RESULTATREDOVISNING

Slutresultatet av musikproduktionen beror saklart pa hur kunnig man &r med inspelning,
mixning och mastering. En produktion med dessa metoder (datortrummor, VST
forstarkare, osv.) gjord av en kunnig ljudtekniker med begrénsad budget blir hogst
troligen béttre &n en nybdrjares som anvander samma metoder med toppen utrustning.
Med en begransad budget, sa som denna, och dessa metoder gar det minsann att gora en
bra musikproduktion (Skaag 2016). Ljudkvalitén med denna utrustning och mjukvara ar
bra och det gar smidigt att arbeta med dem. D& man gér en sadan musikproduktion med
begransad budget ar det valet av ljudpluginner som spelar stor roll. Det I6nar sig att
prova mellan olika ljudpluginner, ifall man inte hittar det énskade soundet genast. Det
kan kénnas som att man har t.o.m. for mycket valméjligheter, vore det sen bra eller

daligt.

Masteringsskedet ar nagot som man kan missa pa da man mastrar pa egen hand, ifall
man inte har sin hemmastudio byggt for mastering pa tanke pa akustik och utrustning.
Detta ar situationen for denna musikproduktion men mastering har anda gjorts. Med att
jamfora till annan professionellt producerad musik har man en tongivande referens till
vad man ska strava till med sin slutliga produktion. Detta hjalper ocksa att forsta hur
ljud later ur sin egna ljudanléaggning och pa sa satt kan man anpassa sig battre till dem
(Strong 2014 s. 308). Det rekommenderas att lyssna pa masteringen ocksa med horlurar
for att noggrannare hora ifall det sker buggar man annars kanske inte hor (White 1999).

Bland de svaraste sakerna ar att fa datortrummorna att lata akta. Enligt Oskar Skaag ar
detta ocksa storsta problemet med denna musikproduktion. Hi-hatten, symbalerna och
speciellt virveltrumman har brist pa variation av samplar for att skapa ett mer akta
trumsound, som orsakar att det later fejk. Man borde satsa pa flera sampel som anvands
slumpmassigt och att samma sampel aldrig kommer efter varandra. For lite variation
orsakar ett fejkat sound (Skaag 2016).

| 6verlag dar mixningen av laten ratt sa bra enligt Oskar Skaag. Sma ekvaliserings-
problem dock: lite for mycket forstarkning under 60 Hz, saknar lite lagmid och lite val
klar. Botten borde flyttas till hdgre frekvens (Skaag 2016). Andra problem enligt Oskar
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Skaag ar "fretbuzz” (dvs. surrandet pa antagligen laga strangar orsakat av strangar som
tar fast i nagot band) pa ”Clean gtr”, "Main gtr” later lite plastig och synten &r for hogt i
ett skede av laten. “Fretbuzz” problemet gar tyvarr inte att fixa utan att banda pa nytt
gitarren men de andra problemen gar att fixa i mixet. Eftersom detta ar en sjalvstandig
produktion skulle det dock inte vara s stor grej att banda ”Clean gtr” pa nytt, aven i
detta skede.

For att uppna béttre resultat galler det att satsa mera pa datortrummorna och tanka pa
hur dkta allting later och eventuellt hitta andra metoder for att uppna béttre resultat. Det
handlar framst om att anvanda flera samplar och kanske ett olikt samplingsverktyg.

Oskar Skaag séger:

Att gora forproduktion pa detta sétt ser jag inget problem med. Funkar perfekt. Inte heller ett problem
att gora ett helt album men da krévs det nog béttre sampel an vad du nu har anvént. Ar helt siker att
man kan uppna ett jattebra resultat med en laptop och en daw. Man behéver inte en hel studio for att
gora bra musik. Men ju battre sampel man gor eller skaffar desto battre resultat.

Musikproduktionen kan man lyssna pa via lanken som finns i bilaga 1.

7 DISKUSSION

Dé man sjalvstandigt gor en musikproduktion kan de bli svart till slut att avgéra om
allting later som det ska eftersom man blir lite dov till det man arbetar med, ifall man
inte far feedback av nagon utomstaende eller vet sjalv precis vad man gor. Det lonar sig
att ha nagra dagars pauser mellan de olika skedena, speciellt mellan mixning och
mastering (Strong 2014, s. 308), och lyssna pa musiken med olika horlurar och

hogtalare for att fa nya perspektiv (Crich 2011, s. 278).

Det ar svart att avgdra sjalv om trummorna later akta eller inte, pga. man sjalv vet att de
ar datortrummor. T.ex. om man lyssnar pa annan musik och man ar medveten att de
anvander datortrummor kan det lite spoliera upplevelsen, ifall man ser det som ett
problem. Man maste bestamma vad man néjer sig med, far det lata som datortrummor
eller inte? Jag medger att sarskilt virveltrumman for denna produktion avsl6jar nog att

det ar frdga om datortrummor och det later kanske inte sa varst bra. Detta beror pa



humaniseringen jag gjort. Soundet av samplade trummor kan ocksa avsldja, men det
finns musik vars trumsound later som datortrummor fastan de ar spelade pa riktigt, pga.
sampling. Om man vill ha trummor som later dkta, sarskilt om de ska lata akustiska och
musikaliska med mycket variation, I6nar det sig att tdnka pa att banda riktiga trummor

istallet for att anvanda datortrummor.

Jag rekommenderar inte att man bandar ett slutligt album pa detta vis, ifall man inte &r
sjalv professionell och soker efter toppen kvalité, men fér demoinspelning och
forproduktion fungerar denna stil mycket bra. Men med detta sagt betyder det inte att
det &r omojligt att gora ett lyckat aloum med liknande produktion stil. | sa fall bér man
gora datortrummor med béttre metoder an vad denna forskning presenterade. Slutligen
beror allting pa sin egen kunskap och erfarenhet inom omradet. Denna musikproduktion
var menat som en demoinspelning och for detta andamal tycker jag att det lyckades
mycket bra.

En liknande musikproduktion med dessa metoder I6nar det sig absolut att gora ifall:
e Man har en begransad budget
e Man ska gora en forproduktion eller demoinspelning
e Man vill lara sig mera om att producera musik
Dessutom kan man spara pengar med att géra produktionen sjalv och man har friheten att

banda nar man vill.

Vidare forskning sarskilt inom skapandet av datortrummor och hur fa det sa bra som
mojligt och skapandet av bra gitarrsound tillsammans med impulsresponser och VST
forstarkare ar rekommenderat. Vidare forskning egentligen inom allting &r
rekommenderat och 16nsamt. Man kan alltid l&ra sig nya saker och teknologin utvecklar
sig hela tiden. Det &r inte hardvaran som begrénsar ett sddant arbete (forutsatt att man
har det nédvandiga) utan det &r brist pa mjukvara och kunskap som gor det.
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Tycker att mixen 6verlag ar ganska bra balanserad. Finns lite for mycket lowend, under
60Hz. Lite val hypead, bright. Saknar lite lowmid k&nns ganska tunn, fast det finns

mycket lowend. Borde flytta opp botten till en hogre frekvens.

Bastrumman later ganska lik 6vrig musik i genren. Eftersom den ofta &r samplad och
korrigerad. Virveln later inte bra, borde vara mera variation i samplen for att 6vertyga.
Later otroligt fejk, speciellt dubbelslagen. Trummorna éverlag helt ok men virveln
forstor det mesta. Satsa pa flera sampel nasta gang som anvands random och aldrig
samma sampel tva ganger efter varandra. Hihat har lite samma fenomen som virveln
later jatte onaturlig, speciellt rytmiskt och amplitud massigt. For lite variation later jatte
fejk. Symbolerna borde ocksa ha mera liv och variation. Later som ett och samma slag

om om igen.

“Akustisk” gitarr 1 intro och outro 1iter skrélligt och inte sa fint som borde. Sédkert beror
det mest pa att gitarren kanske inte varit sd bra instélld later som “fretbuzz”. Annars ett
ganska typiskt halvakustiskt sound. Passar laten bra. Basen later som en bas.
Elgitarrerna. Kompgtr later ganska plastiga och fejkade. Solo och leadgtr later
naturligare och béattre. Synten vid 4:32 tycker jag ar for hog i mixen. Star ut och kanns
paklistrad.



Sa latmixen tycker jag kanns ratt sa bra. Det storsta problemet med laten ar att
trummorna later alltfor samplade pga for lite variation i samplen. Med battre trummor

skulle allt funka battre.

Att gora forproduktion pa detta sétt ser jag inget problem med. Funkar perfekt. Inte
heller ett problem att gora ett helt album men da kravs det nog béattre sampel dn vad du
nu har anvant. Ar helt saker att man kan uppna ett jattebra resultat med en laptop och en
daw. Man behdver inte en hel studio for att gora bra musik. Men ju battre sampel man

gor eller skaffar desto béttre resultat.



